An annotation tool for dermoscopic image segmentation
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ABSTRACT

Dermoscopy is a non-invasive diagnostic technique for the in
vivo observation of pigmented skin lesions, and it is currently
one of the most important imaging techniques for melanoma
diagnosis.

Since the diagnostic accuracy of dermoscopy significantly
depends on the experience of the dermatologists, and the
visual interpretation and examination of this kind of images
is time consuming, several computer-aided diagnosis systems
of digital dermoscopic images have been introduced.

However, a reliable ground truth database of manually
segmented images is necessary for the development and val-
idation of automatic segmentation and classification meth-
ods. As the ground truth database have to be created by
expert dermatologists, there is a need for the development of
annotation tools that can support the manual segmentation
of dermoscopic images, and this way make this task easier
and practicable for dermatologists.

In this paper we present an annotation tool for manual
segmentation of dermoscopic images. This tool allows build-
ing up a ground truth database with the manual segmenta-
tions both of pigmented skin lesions and of other regions of
interest, whose recognition is essential for the development
of computer-aided diagnosis systems.
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1. INTRODUCTION

Skin cancer is one of the most common cancers in humans.
Malignant melanoma is the most deadly form of skin can-
cer, and its incidence has been rapidly increasing over the
last years. Successful treatment of melanoma depends di-
rectly on early diagnosis, because when detected in an early
and non-invasive stage, the malignant melanoma can surgi-
cally be removed (excised) with an excellent prognosis for
the patient [2, 3].

In order to improve the accuracy of melanoma diagno-
sis various imaging techniques have been explored. Among
these, dermoscopy is clinically one of the most relevant imag-
ing techniques for pigmented skin lesions diagnosis. Der-
moscopy is a non-invasive diagnostic technique for in vivo
observation, allowing a better visualization of the surface
and subsurface structures, and the recognition of morpho-
logic structures not visible by the naked eye [1, 4].

The increasing demand for dermoscopic exams calls for
the development of computer-aided diagnosis systems that
can assist the clinicians. In this context the development of
a ground truth database is of crucial importance [6].

In this paper we propose an annotation tool for setting
up a ground truth database of manually segmented dermo-
scopic images. This is a customized tool for dermoscopy, but
can easily be adapted to other medical imaging applications.
The presented tool allows segmenting a pigmented skin le-
sion from the image, and also performing the segmentation
of other regions of interest, such as regions with different
colors, typical or atypical vascular networks, dots, globules,
star burst patterns, etc.

To accomplish this purpose, this tool has several func-
tionalities including: image upload and display, manual seg-
mentation, region labeling, boundary reshaping, a posteriori
boundary edition, multi-user ground truth annotation and
segmentation comparison, and storage of the segmented im-
ages. Taking its functionalities into account this tool has
some advantages with respect to other existing annotation
tools, namely better freehand drawing and boundary reshap-
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Figure 1: Initial aspect of the graphical interface.
Toolbar Buttons: 1-“Load Images”; 2-“Save as”; 3-
“Zoom in”; 4-“Zoom out”; 5-“Manual segmentation”;
6-“Pointwise boundary reshaping”; 7-“Local bound-
ary reshaping”; 8-“Region labeling”.

ing functionalities.

2. ANNOTATION TOOL DESCRIPTION

This application allows performing the manual segmen-
tation of dermoscopic images and storing the result of seg-
mentation. For this purpose, the user has a set of tools to
be used sequentially to achieve the desired result. The main
functionalities of this interface are:

(i) Image upload and display;

(ii) Manual segmentation (of the lesion or other regions of
interest);

Region labeling;

)
(iv) Boundary reshaping;

) A posteriori boundary edition;

) Multi-user ground truth annotation and
segmentation comparison;

(vil) Storage of segmented image.

The graphical interface was set up based on the requirements
and suggestions of dermatologists and was implemented in a
MATLAB environment (7.9.0 R2009b) taking into account
its image processing toolbox and graphical facilities. Figure
1 shows the initial aspect of this graphical interface.

2.1 Imageupload and display

With this application it is possible to open one image or
several images at once. For this purpose, it is necessary to
select the option “Load images” in the “File” menu, or simply
press the button 1 on the toolbar, Figure 1.

Then a dialog box appears that enables the user to browse
and select the image to be segmented. To open multiple im-
ages, simply press CTRL key and select the desired images.

The loaded image is displayed on the left side of the inter-
face. If several images have been loaded, the user can easily
change the image that is being displayed through the slider
button, Figure 1.

Figure 2: Image on the left: initial contour drawn by
the user, with some undesirable extra lines (marked
with circles). Image on the right: final contour after
morphological filtering. Note that the final contour
is smoother than the initial and without undesirable
extra lines.

2.2 Manual segmentation

In order to perform the manual segmentation, this appli-
cation allows to draw a freehand region of interest on the
loaded image. It is important to note that the manual seg-
mentation can be performed using a pen tablet or a mouse.
The user can choose between performing the manual seg-
mentation of the lesion or other regions of interest through
the radio buttons on the panel “segmentation”.

To achieve the manual segmentation it is necessary to se-
lect in the “Tools” menu the option “Manual Segmentation”,
or simply press the button 5 on the toolbar, Figure 1. Then,
the user must click and drag the pen tablet to draw the con-
tour of the lesion (or the contour of other regions of interest).

When the user confirms the segmentation, the image with
the final contour is displayed on the right side of the inter-
face, Figure 2.

Note that the user can only confirm and complete the
segmentation when a closed contour is drawn. When the
user lifts the pen from the tablet before closing the contour,
the contour remains open. However, while the contour is
open there is the possibility of resuming drawing until the
user completes and closes the contour.

To our knowledge other available manual segmentation
tools, such as ImageJ, do not have this possibility, since
when the drawing is interrupted the contour is automatically
closed with a straight line between the beginning and the end
point.

To obtain the final contour from the initial one (drawn by
user), a binary mask of the initial contour is first created,
in which pixels with intensity value of 1 correspond to the
segmented object, while pixels with value 0 correspond to
the background. Then a morphological filtering is applied
to this binary mask in order to smooth and remove extra
lines that not belong to the contour. These lines may arise
when the contour is drawn by means of multiple segments,
especially at the points of intersection of these segments,
Figures 2 and 3.

Basically, morphological filtering is divided into three stages
(i) morphological erosion; (ii) selection of the biggest binary
object from the image and (iii) morphological dilation. The
user also has the possibility to select the degree of smoothing



Figure 3: Morphological filtering: Initial contour
drawn by the user (a), Binary mask of initial contour
(b), Binary image after morphological filtering (c),
and Final contour obtained from image “c” (d).

of the morphological filter between low, medium and high.
In each of these morphological operations a flat disk-shaped
structuring element is used, with a specific radius for each
smoothing level (low: radius 1; medium: radius 3; high:
radius 7).

The manual segmentation of other regions of interest can
be done in a very similar procedure to the manual segmenta-
tion of the lesion. For this purpose, the user must select the
“Other regions of interest” radio button in the panel “Seg-
mentation”, and perform the segmentation of the desired
regions in the same way as for the whole lesion. The con-
tours of all segmented regions are shown simultaneously in
the right window, Figure 4.

2.3 Region labeling

Another available functionality of this graphical interface
is “Region labeling”, which was developed based on the sug-
gestions of dermatologists and allows labeling the segmented
regions. The user must select the option “Region labeling”
in the “Tools” menu, or simply press the button 8 on the
toolbar, Figure 1.

Afterwards, the user should move the pointer over the
desired segmented region and click on it. This produces an-
other window where a number of default labels are available
for selection. These labels include the main dermoscopic
features and also the six typical colors that can be present
in a dermoscopic lesion, Figure 5. The possibility of making
a different annotation is also available.

After selecting the desired label for each segmented re-
gion, the corresponding text annotation is placed inside the
respective region, Figure 4.

2.4 Boundary reshaping

Even after finishing the manual segmentation it is possi-
ble to make some adjustments in the contour, if necessary.
Two distinct methods were implemented to reshape the con-
tour previously done, namely “Pointwise boundary reshap-
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Figure 4: Segmentation example of other regions of
interest with the respective labels.

ing” and “Local boundary reshaping”.

To our knowledge other available manual annotation tools,
for instance ImageJ, do not offer this possibility, and hence
this is another advantage of our manual segmentation tool.

2.4.1 Pointwise boundary reshaping

This method must be used to make small adjustments in
the contour, because the reshaping is done point-by-point.
For this, the user must select the option “Pointwise Bound-
ary Reshaping” in the “Tools” menu, or simply press the
button 6 on the toolbar, Figure 1. Forthwith the bound-
ary turns red with some control points. From these points
it is possible to change the shape of the contour. For this,
the user must click and drag the control points to their new
positions, Figure 6. The interactive behaviors supported by
this tool are described below:

1. Boundary Reshaping: Move the pointer over a con-
trol point. The pointer changes to a circle. Then, click
and drag the control point to its new position.

2. Adding a new control point: Move the pointer
over the boundary and press the A key. Click the left
mouse button to create a new control point at that
position on the boundary.

3. Deleting a control point: Move the pointer over a
control point. The pointer changes to a circle. Then,
click the right mouse button and select the option
“Delete Vertex” from the context menu.

2.4.2 Local boundary reshaping

This method should be used when it is necessary to make
great adjustments in the initial contour. For this, the user
must select the option “Local Boundary Reshaping” in the
“Tools” menu, or simply press the button 7 on the toolbar,
Figure 1.

Basically, this method allows the user to draw a line to
define the new shape of the contour. The line must intersect
the initial contour at least in two points to form a closed
contour. This can be used to increase or reduce the size of
the initial contour. Note that it is possible to increase and
reduce the size of the contour with a single line, Figure 7.

The final contour, Figure 7(h), is obtained through a set
of logical, arithmetical, and morphological operations:
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Figure 5: “Region labeling” window, in which there
are several default labels that the user can select.

(i) First, a binary image from the initial contour and an-
other binary image from the new line are created, Fig-
ure 7 (c) and Figure 7 (d) respectively;

(ii) Image subtraction between image (c) and (d), Figure
7 (e);

(iii) Selection of the biggest binary object from the image,
and application of a logical OR operator between im-
age (e) and (d), Figure 7 (f);

(iv) Application of a morphological filling in order to fill the
image holes, and then a morphological open is used to
remove the extra lines, Figure 7 (g).

2.5 A posteriori boundary edition

This functionality was implemented in order to allow the
visualization and the edition of a previously existing seg-
mentation. In this way, segmentation may be performed
in a first stage by less experienced (or even non medical)
staff and then corrected by specialists. This can be used
for medical training as well as for reducing the workload of
the experts when building a ground truth database of large
dimension.

Therefore, before starting the manual segmentation, the

tool automatically searches in the current ground truth dataset

if there exists a previously stored segmentation. In this case,
the user can choose to visualize the previously existing con-
tour and edit the border making use of the two existing
boundary reshaping functionalities (“Pointwise boundary re-
shaping” and “Local boundary reshaping”). Otherwise, the
user can discard the referred contour and execute a new
manual segmentation following the proposed procedure.

2.6 Multi-user ground truth annotation and
segmentation comparison
The manual segmentation of dermoscopic images is quite
subjective and therefore it is desirable to collect segmenta-
tions performed by more than one dermatologist in order to

Figure 6: Pointwise boundary reshaping: Initial
contour (a), Initial contour with control points to
reshape the contour (b), Initial contour (solid line)
and the reshaped contour (with control points) (c),
and Final contour (d).

create a reliable ground truth dataset [5]. In this regard,
with this tool it is possible to segment and create anno-
tations on the same image by different users. During the
initialization of the interface the user can select an existing
ground truth dataset (previously created by another user)
or create his own new ground truth dataset (corresponding
to his own segmentation), Figure 8.

As each user is associated to one ground truth dataset, this
tool is capable of making the comparison between segmen-
tations of different users for the same image. To accomplish
this purpose visual and quantitative comparisons are both
presented.

When this functionality is used for a given image another
window is opened containing a list box with all datasets that
have a segmentation of the current image for user selection.
The user can compare his segmentation with the segmenta-
tions of one or more datasets, Figure 9.

For visual comparison the tool shows two or more seg-
mentations on the same image. In addition, when only two
segmentations are considered for comparison three perfor-
mance metrics are given for the quantitative assessment of
the segmentation discrepancies, namely the Hammoude dis-
tance, the false negative rate, and the false positive rate [6].

2.7 Storage of segmented image

Finally, this interface also allows storing the result of each
manual segmentation. The ground truth dataset is created
and organized automatically as the manual segmentations
are stored. For each segmented image, a main folder with
the same name of the image is created. In addition, two ded-
icated folders are created inside the main folder, one of them
is for the storage of the manual segmentation of the lesion,
and the other is for the storage of the manual segmentations
of other regions of interest.

The segmentation result is saved as a binary image, where



Figure 7: Local boundary reshaping: Initial contour
(a), Initial contour and a new line to reshape the
contour (b); Intermediate steps (c)-(g), and Final
contour (h).

pixels with intensity value of 1 correspond to the segmented
object, while pixels with value 0 correspond to the back-
ground. If different regions of interest were segmented, an
individually binary image is created for each segmented re-
gion. Besides the binary image, a print of the original image
with the contours of all segmented regions and the respec-
tive labels is stored. This image is created and stored since
it provides a suitable global information of the manual seg-
mentation.

3. IMAGE ACQUISITION AND GROUND
TRUTH CREATION

The clinical database of Hospital Pedro Hispano (HPH)
has over 4000 cases with dermoscopic images of various types
of lesions, all of them obtained under the same conditions
through Tuebinger Mole Analyzer system. A total of 150
dermoscopic images were selected from the database along
with the clinical diagnosis, being 70 melanocytic nevi (reg-
ular), 35 dysplasic nevi, and 45 melanomas. The images are
in 24-bit RGB color, with 768x560 pixels.

In a first stage, the manual segmentation of 70 dermo-
scopic images (from the initial set of 150) was performed by
hand in full sized printed images by Dr. Jorge Rozeira !
Afterwards, the set of manual segmentations were scanned
and rectified. The contour of the lesions was identified on
these digital images to produce a binary image for each le-
sion. Nevertheless, this procedure was cumbersome, and
according to the expert dermatologist opinion the manual

LCo-author, and an expert dermatologist with over 10 years
of experience in dermoscopic image analysis.
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Figure 8: Window for ground truth dataset selec-
tion.

segmentation performed in a printed paper is not reliable
enough in order to construct a ground truth dermoscopic
image database.

Meanwhile, the remaining images are being segmented us-
ing the presented annotation tool and the proposed method-
ology. This procedure meets the wishes expressed by derma-
tologists who recognize a superior and adequate performance
of the presented software tool for manual segmentation.

4. CONCLUSIONS

An annotation tool that can support the manual segmen-
tation of dermoscopic images was presented in this paper.
This tool allows building up, in a very simple and fast way,
a ground truth database to be used in the assessment of
automatic segmentation and classification methods.

This interface was developed based on the requirements
and suggestions of dermatologists, and has been used by
them in the creation of the ground truth database.

The main functionalities of this tool are: image upload
and display, manual segmentation, region labeling, bound-

ary reshaping, a posteriori boundary edition, multi-user ground

truth annotation and segmentation comparison, and stor-
age of the segmented images. Based on its functionalities,
this tool offers some advantages with respect to other exist-
ing annotation tools, namely better freehand drawing and
boundary reshaping functionalities.

Besides the manual segmentation itself, one of the most
interesting tools is the boundary reshaping, with which the
user can correct the shape of the contour previously done.
To achieve this purpose , three distinct methods were im-
plemented.

As future work some experimental results will be per-
formed in order to validate this interface. This experimental
results may include the analyze of the required times, user
satisfaction, and also the comparison of our tool with others
annotation tools beyond the ImageJ.
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